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Q: | already use a different authenticator app for something else, do I still
need to download Microsoft Authenticator?

A: Possibly not. If your current authenticator app supports QR codes then you should be fine to use
that. If you find that it doesn’t then please download Microsoft Authenticator.
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Q: I've tried logging on from home but | just end up back at the Entrust
portal?

A: Ok, we think we may know what’s happened here! The address for the new remote portal is
https://myapps.york.gov.uk. We're suggesting that the first time you use this you save it to your
favourites/bookmarks in your browser. If you’ve ended up at the Entrust portal it is most likely that
you have typed the address into the search window rather than the address bar:



https://myapps.york.gov.uk/
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ICT Portal | ICT Portal | City of York Council

hittps: //www york gov ukiinfo/20188/ict_portal/1586/ct_portal v

Authorised City of York Council staff and partners can remotely access the Council's information,
applications, communications and ICT systems over a secure .

My Account | My Account | City of York Council

hittps://www.york gov.uk/MyAccount

My Account is the easiest way to access your council services online. . My Account allows you to
access and manage a range of council services when you want to. ... You can manage council tax
and benefits services from My Account as well as report environmental issues

Missing: myapps | Must include: myapps

Citrix Receiver
hitps://www.citrix.com/account.html
No information is available for this page.

Leam why
Missing: york | Must include: york

As this is still in pilot stage Google (and the other available search engines) are unaware of the new
portal so will direct you to the closest they are aware of, the old one. You need to put the
https://myapps.york.gov.uk into the Address Bar at the top of the browser:



https://myapps.york.gov.uk/
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This will take you to the new portal:
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Welcome to the CYC Application Portal. Please log on to continue

Submit

You are about to log in to City of York Council's private network. All
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Communications Palicy, which is available on the Intranet (COLIN), or
from HR. Loggi s tance of the terms and conditions of
this policy. Unautho by any individual may lead to

se refer to the how to guidance at
.gov.ukfictportal

Q. What'’s happened to Outlook, where’s it gone?

A. Outlook is still here! The colour of the icon has changed along with the version:

Previously Outlook 2007 Now Outlook 2016
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Q. What’s happened to Lync, where’s it gone?

A. Lync is still here, under its new name! The name of it has changed to Skype for Business

Previously Lync Now Skype for Business 2016

S

Skype for
Business 2016

Q. Why can | see a message saying “Citrix HDX RealTime Connector —
Unoptimized”. Has something gone wrong with my session?

A. In short, no! This is functionality unavailable at the moment but which we intend to use in the
future. Please ignore the message:

p « Critrix HDX RealTime Connector -

Unoptimized

Q. How do | change my default printer?
A. In the system tray by the clock there is a blue TV icon Right-click this and choose Manage

(o

Citrix WEM
Printer Man...

Printers. Alternatively you can double-click the Citrix WEM Printer Management icon
on the desktop.



B Manage printers X

- Find Clear

Name Location Default | Comment
EPSOM XP-402 403 405 406 Series... F

f_&_]‘ Foxit Reader PDF Printer {from Ex... ® Auto Created Clien...
r_ﬁl_ Microsoft Print to PDF x
Lgd Microsoft Print to FOF {from Exter... ® Auto Created Clien...
f_&_]‘ Microsoft XPS Document Writer x
£ | Send To OneNote 16 x
Lﬁl Send To OneNote 2016 {from Exte. .. ® Auto Created Clien...
&2 | uniflow_print 4
Vuniflowprintyuniflow_print Clear
Setas default Close

From here you can set your default printers. You settings should have migrated across but if you
ever need to change them then this is where you do it!

Q. How do find my files?

A. On a type B desktop (not a thin client) you can right-click on the Windows icon =
in the corner and select Open Windows Explorer or you can left-click and choose Computer

On a full desktop (Thin client or when opening CYC Desktop) this can be reached by right-clicking on

the Windows icon E in the bottom left of your desktop and choosing File Explorer:

File Explorer
Search

Control Panel

Shut down or sign out

Desktop

Q: How can | make Outlook look like it used to?



A: You can’t make it look exactly like it used to, Microsoft have decided to change the style and
there’s nothing we can do about that. But you can make it look a little more familiar if you follow
these steps:

When you first open Outlook it might look like this:
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There are a number of settings you can change to make it more usable, some people don’t like the
large white expanses and prefer a little contrast. The option for this is in File > Office Account >
Office Theme and select Dark Gray:
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To remove the reading pane select the View tab from the ribbon and then set the Reading pane

option to Off:
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Hi everyone,

Could | please ask how you're all getting on with testing this latest version?

Appreciate we're all busy but it would be good to sign off on this test environment this week

to then update live early next.

We actually used the test site for our training last week so I'm pretty confident it's fully

operational, please do test a few things on behalf of your areas though.

Many thanks,
Matt

From: Stroud, Matthew

Sent: 21 September 2018 15:01

To: Bennett, Stephen; Chelton, Rachael; Wilson, Jacquie; Wilson, Cindy; Collins, Melanie; Rodriguez-Nuno, Claudia
Cc: Billings, Guy; Smith, Philippa; Meadows, Sara

Subject: RE: Civica APP 8.6

Superb, cheers Steve,

RE: Important - Children”...  Sun 13:30
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Alternatively you can set the pane below your emails by setting the option to Bottom.
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Appreciate we're all busy but it would be good to sign off on this test environment this week to then update live early next.

We actually used the test site for our training last week so I'm pretty confident it's fully operational, please do test a few things on

albalf of il do.

If these panes do not appear with the size you prefer you can drag the bar up or down if you hover
around the below area until the cursor changes:
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We actually used the test site for our training last week so I'm pretty confident it's fully operational, please do test a few things on
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Could | please ask how you're all getting on with testing this latest version?
Appreciate we're all busy but it would be good to sign off on this test environment this week to then update live early next.

We actually used the test site for our training last week so I'm pretty confident it's fully operational, please do test a few things on
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Please explore the settings until you have the view you prefer.

Q: I've got 2 months showing on my Calendar and | only need one?

A: This is the default view but many of you prefer to see just the one month:
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You can drag the panel that contains the calendars up by hovering over the below area until the
cursor changes:
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Q: I've clicked something in Outlook and my menu has disappeared?

A: Don’t worry, this is fairly common whilst everyone is getting used to the new functionality!

Depending on what you’ve lost there are easy ways to get these back. If we start with how you may
have set your view:
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Deleted ltems ICT Service Desk Mailbox Christmas Dates - Creditors Mon 03/12/2018 10:36 5KB
Junk E-Mail Freeman, Jeannie Citirx update Mon 03/12/2018 10:11 4KB
Outbox Raja, Farhad RE: Aspire on new Citrix environment Mon 03/12/2018 10:04 100 KB
 Search Fold Clarke, Katy (CYTLimited) RE: Aspire on new Citrix environment Mon 03/12/2018 09:50 97 KB
earch Folders
Raja, Farhad RE: Aspire on new Citrix environment Mon 03/12/2018 09:49 79 KB
] P13 |ﬂ - @J Mchamara, Brendan TRAMMAN / CRYSTAL Training Room Booking Mon 03f12/2018 09:35 33KB
Bull, Karen {CYT Limited) RE: Aspire on new Citrix environment Mon 03/12/2018 08:51 75 KB hd
Beee e Fa AT [ - B .- L T N T m ==
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1) You might find that your folders have disappeared from the side?

Home Send / Receive

Folder

Inbox - Guy.Billings@york.gov.

U Tell me what

uk - Qutlook

~

H

c9 d?‘ Show as Conversations =] Il Reverse Sort Folde.r Pane~ - Remin.ders Winéow
Change View Reset - . ) Message Arrange =] Add Columns [T Reading Pane ~ People EEs Open in New Window
View ~ Settings View CaveE SR Preview~ By~ *~ Expand/Collapse~ [ To-Do Bar~ Panes T Close All ltems
Current View Messages Arrangement Layout People Pane Window
» Al Unread [ search Current Mailbox (Ctrl~E) P [ current Mailbox_~|
Date -
O@ |FroM |suBJECT |RECENVED ¥ |size |
4 Date: Today
H Holtham, Claire ¥X filng system dms Mon 03/12/2018 12:20 15KB |*
Smith, Philippa RE: TRANMAN f CRYSTAL Training Room Booking Mon 03122018 12:16 22KB |*
@J McNamara, Brendan RE: TRANMAN / CRYSTAL Training Room Booking Mon 03/12/2018 12:00 34 KB |"
’_f‘?p, @J Hugh de Selby Training Room F0O30 - C... FW: Crystal Reports Training - Brendan McNamara x2497 Mon 03/12/2018 11:12 29KB |*
’_f‘?; @J Hugh de Selby Training Room F0O30 - C... FW: Crystal Reports Training - Brendan McNamara x2497 Mon 03/12/2018 11:12 29 KB |’
] Freeman, Jeannie RE: Citirx update Mon 03f12/2018 11:03 7KB |'
Robinson, James RE: Citirx update Mon 0312/2018 10:40 54KB |b
ICT Service Desk Mailbox Christmas Dates - Creditors Mon 03/12/2018 10:36 5 KB |*
Freeman, Jeannie Citirx update Mon 03122015 10:11 4KB |'
23 Raja, Farhad RE: Aspire on new Citrix environment Mon 03/12/2018 10:04 100 KB |"
Clarke, Katy (CYTLimited) RE: Aspire on new Citrix environment Mon 03/12/2018 09:50 97 KB |*
- Raja, Farhad RE: Aspire on new Citrix environment Mon 03/12/2018 09:49 79KB |*
@J McMamara, Brendan TRANMAM f CRYSTAL Training Room Booking Mon 03f12/2018 09:36 33KB |’
RE: Aspire on new Citrix environment

To get these back simply click the > arrow above Unread Mail to pop the

Bull, Karen (CYT Limited)

lling

rhe.gov.uk

Mon 03/12/2018 08:51
. =

menu back up:

75K8 >

~

¢

Home Send / Receive Folder Q Tell me what you want to do...
( .n'? Show as Conversations l 11 Reverse Sort ] Folder Pane - Reminders Window
@ - . - A =] Add Columns EReading Pane - Gizard %Dpenin New Window
ange \View Resel vercation Settinme essage Arrange eople
View = Settings View ST LRl Preview~ By= ¥~ Expand/Collapse~ [T To-Do Bar - Pane~ Il_'::';CIose..ﬂdl Items
Current View Messages Arrangement Layout People Pane Window
- ‘ Search Current Mailbox (Ctrl+E} pel | Current Mailbox v‘
1 Favorites
e B
4 Mailbox - CitrixPilot |suBzECT [RECEVED ¥ [size  |¥
4 Inbox 20
. >
Actioned XX filing system dms Mon 03/12/2018 12:20 15KB |
SR RE: TRANMAN f CRYSTAL Training Room Booking Mon 03/12/2018 12:16 228 |»
4 it
e RE: TRANMAN / CRYSTAL Training Room Booking Mon 03/12/2018 12:00 34KB >
Read/Auto 93 Room F030 - C... FW: Crystal Reports Training - Brendan McNamara x2497 Mon 03/12/2018 11:12 29 KB |
Sent Room F030 - C... FW: Crystal Reports Training - Brendan McNamara x2497 Mon 03/12/2018 11:12 29KB |*
Drafts RE: Citirx update Mon 03f12/2018 11:03 7KB |*
RE: Citirx update Mon 03f12/2018 10:40 54k8 |*
S e lox Christmas Dates - Creditors Mon 03/12/2018 10:36 5KB >
Deleted ltems Citirx update Mon 03/12/2018 10:11 4k8 >
Junk E-Mail RE: Aspire on new Citrix environment Mon 03/12/2018 10:04 woks |
Outhox ad) RE: Aspire on new Citrix environment Mon 03/12/2018 09:50 97 KB |*
-
RE: Aspire on new Citrix environment Mon 03/12/2018 09:49 79 KB |’
= a8 Iﬂ P TRANMAN f CRYSTAL Training Room Booking Mon 0312/2018 09:36 33KB |’
RE: Aspire on new Citrix environment

Followed by the pin W to keep it there:
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Inbox - Guy.Billings@york.gov.uk - Outlook

Send [ Receive Folder Q Tell me what you want to do...

( .n'-a' S —— l Tl Reverse Sort Folder Pane ~

Reminders Window

- ¥ . x A =] Add Columns EReading Pane - — ra[lperlin New Window
ange View Reset oG essage Arrange eople |
View - Settings View Preview~ By~ T Expand/Collapse~ [T To-Do Bar Pane - [ Close All ltermns
Current View Messages Arrangement Layout People Pane Window -~
i <
I» Favorites All Unread | Search Current Mailbox (Ctri<E) O | Current Mailbox v|
4 Mailbox - CitrixPilot pate_ ¥ E
4 nbox 20 VD0 |FROM | suBJECT |RECEVED ¥ |size ¥
Actioned “ Date: Today
: - [
4 ASC Pilot 30 Holtham, Claire XX fling system dms Mon 03122018 12:20 15KB |
Smith, Philippa RE: TRANMAN / CRYSTAL Training Room Booking Mon 03122018 12:16 22KB |’
fesd/Buiolds i McNamara, Brendan RE: TRANMAN / CRYSTAL Training Room Boo... Mon 03/12/2018 12:00 34KB |*
Sent [Z2 [ Hugh de Selby Training Room... FW: Crystal Reports Training - Brendan Mc... Mon 03/12/2018 11:12 29 KB |
Drafts [Z2 [ Hugh de Selby Training Room... FW: Crystal Reports Training - Brendan Mc... Mon 03/12/2018 11:12 29 KB |
- . >
Sent ltems Freeman, Jeannie RE: Citirx update Mon 03f12/2018 11:03 7KB |
Robinsan, James RE: Citirx update Mon 03f12/2018 10:40 54 KB |'
Deleted Items ICT Service Desk Mailbox Christmas Dates - Creditors Mon 03/12/2018 10:36 5KB |~
Junk E-Mail Freeman, Jeannie Citirx update Mon 03/12/2018 10:11 4KB |“
Outbox Raja, Farhad RE: Aspire on new Citrix environment Mon 03/12/2018 10:04 100 KB |“
 Search Folders Clarke, Katy (CYTLimited) RE: Aspire on new Citrix environment Mon 03/12/2018 09:50 97 KB |*
Raja, Farhad RE: Aspire on new Citrix environment Mon 03/12/2018 09:49 79 KB |"
A FY E - @J McNamara, Brendan TRAMMAN f CRYSTAL Training Room Booking Mon 03122018 09:36 33KB |’
Bull, Karen (CYT Limited) Mon 03/12/2018 08:51 75 KB | hd
M PR AT Mleeeeaimman m n _ = =a -

2) Alternatively, you may have lost your ribbon from the top?

Inbox - Guy.
Home Send f Receive Folder View '-:.' Tell me what yr
&1 New Email €| Al Unread [ Search Current Mailbox (Ctri=E) O | Current Mailbox - |
Dat= ¥ E
I Favorites
Y Dy|w |FrRoM | suBIECT RECEIVED ¥ [Er
4 Mailbox - CitrixPilot A DB
4 Inbox 20 ! Robinson, Paul DC closed Mon 03/12/2018 12:59 7KB |
i Holtham, Claire XX filing system dms Mon 03122018 12:20 15k8 [>
Actioned Smith, Philippa RE: TRANMAN [ CRYSTAL Training Room Booking Mon 03/12/2018 12:16 22kB >
4 ASC Pilot 30 @J McNamara, Brendan RE: TRANMAN [ CRYSTAL Training Room Boo... Mon 03/12/2018 12:00 34 KB |“
Read/Auta 93 F&-, @J Hugh de Selby Training Room... FW: Crystal Reports Training - Brendan Mc.. Mon 03/12/2018 11:12 29 KB |“
F‘&.- @J Hugh de Selby Traini ... FW: Crystal Reports Training - Brendan Mc.. Mon 03/12/2018 11:12 29KB |*
£t Freeman, Jeannie RE: Citirx update Mon 03122018 11:03 TKB |"
Drafts Robinson, James RE: Citirx update Mon 03/12/2018 10:40 54K |
Sent ltemns ICT Service Desk Mailbox Christmas Dates - Creditors Mon 03/12/2018 10:36 S5KB |’
Felailas Freeman, Jeannie Citirx update Mon 03f12/2018 10:11 4KB |*
Raja, Farhad RE: Aspire on new Citrix environment Mon 03/12/2018 10:04 w0k >
Sz Clarke, Katy (CYTLimited) RE: Aspire on new Citrix environment Mon 03/12/2018 09:50 97 kB >
Outbox Raja, Farhad RE: Aspire on new Citrix environment Mon 03/12/2018 09:49 79 KB |'
|- Search Folders @J McNamara, Brendan TRAMMAN f CRYSTAL Training R.oom Booking Mon 03122018 09:36 33KB |“
Bull, Karen {CYT Limited) RE: Aspire on new Citrix environment Mon 03/12/2018 08:51 75 KB |“
P Raja, Farhad RE: Aspire on new Citrix environment Mon 03/12/2018 07:44 7O KB |“
— o 4 Date: Last Week
= st ] e

CBSS ICT Systems Support M... RE: Important - Oracle Live CRM is schedule... Sat 01/12/2018 09:55 BKB |“ -

e R T4 el n A - . o e o R R e b et e e ™ ==

If you click any of the menu items such as Home:
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Inbox - Guy.Billings@york.gov.uk - Outlook

T Falder View @ Tell me what you want to do...

Ijl ..J,_:j % x Q @ Q EL Access £3 To Manager ¥ Move - 21 Unread/ Read
. ¥ . b Gain Ie 3 ed Qj - |EJ Team Email v Done =1 Rules ~ H. Categorize = EE! Address Book
Er'::ifl Iter::' &9' s i ;my o E_E' &Reply&Delete ¥ Create New v _@OneNote ™ Fallow Up~ Filter Email
New Delete Respond Quick Steps [F} WMove Tags Find -
4 Mailbox - CitrixPilot o DEEEICED
4 Inbox 20 ! Robinson, Paul DC closed Mon 03/12/2018 12:59 7KB >
Holtham, Claire XX filing system dms Mon 03/12/2018 12:20 15KB |*
Actioned Smith, Philipps RE: TRANMAN / CRYSTAL Training Room Booking ~ Mon 03/12/2018 12:16 22k8 |*
4 ASC Pilot 30 @ Mclamara, Brendan RE: TRANMAN |/ CRYSTAL Training Room Boo... Mon 03/12/2018 12:00 34KB |*
Read/Auto 93 ’_f‘?g @ Hugh de Selby Tr: ... FW: Crystal Reports Training - Brendan Mc.. Mon 03/12/2018 11:12 29KB |*
S ’_f‘?g @ Hugh de Selby Training Room... FW: Crystal Reports Training - Brendan Mc.. Mon 03/12/2018 11:12 29KB |*
Freeman, Jeannie RE: Citirx update Mon 03/12/2018 11:03 7KB |*
Drafts Robinson, James RE: Citirx update Mon 03/12/2018 10:40 54K |
Sent ltems ICT Service Desk Mailbox Christmas Dates - Creditors Mon 03/12/2018 10:36 5KB |*
Deleted Items Freeman, Jeannie Citirx update Mon 03/12/2018 10:11 4KB |’
X Raja, Farhad RE: Aspire on new Citrix environment Mon 03/12/2015 10:04 100 KB |’
pueEE b Clarke, Katy (CYTLimited) RE: Aspire on new Citrix environment Mon 03/12/2018 09:50 97KB |*
Outbox Raja, Farhad RE: Aspire on new Citrib¢ environment Mon 03/12/2018 09:49 79 KB |’
[+ Search Folders @j McMamara, Brendan TRANMAN  CRYSTAL Training Room Booking Mon 03/12/2018 09:36 33KB |"
Bull, Karen (CYT Limited) RE: Aspire on new Citrix environment Mon 03/12/2018 08:51 75KB |*
Raja, Farhad RE: Aspire on new Citrix environment Mon 03/12/2018 07:44 70KB |*
. 4 Date: Last Week
M o CBSS ICT Systems Support M... RE: Important - Oracle Live CRM is schedule... Sat 01/12/2018 09:55 BKB |' -

You can use the pin ™ on the right edge to keep it in position:

Send / Receive Faolder

Inbox - Guy.Billings@york.gov.uk - Outlook

View

O Tell me what

o =a

~

H

r'hl? x E - j (E ) ﬁ E ) A B Access 9-)To Manager ¥ Move - =1 Unread/ Read
. - X~ o Fy O Ie 5 ed Q,S' EJ Teamn Email v Done < Rules - Categorize - [EE: Address Book
ew ew elete eply Reply Forwar o .
Ermail ltems - &~ Al Ex) - € Reply & Delete # Create New 7| I OneMote  [* Follow Up - Filter Email
New Delete Respond Quick Steps [F1 Wove Tags Find
: <
+ Favorites All Unread [ search current Mailbox (cti=E) O | current Mailbox - |
. Date ¥
4 Guy.Billings@york.gov.uk
; Y [O[o |FROM | suBIECT |RECElVED  * |s1zE %
4 Date: Today
Drafts [18]
Paul DC closed Mon 03/12/2018 12:59 7KB |"
b Sent ltems 2 Holtham, Claire XX fiing system dms Mon 03/12/2018 12:20 158 >
Deleted ltems 1 Smith, Philippa RE: TRAMMAN [ CRYSTAL Training Room Booking Mon 0312/2018 12:16 228 |*
Conversation History 1 @J Mchamara, Brendan RE: TRANMAN / CRYSTAL Training Room Boo... Mon 03/12/2018 12:00 34KB >
e [Z2 [ Hugh de Selby Tr. .. FW: Crystal Reports Training - Brendan Mc... Mon 03/12/2018 11:12 20kB |*
un -mall
[Z2 ) Hugh de Selby Training Room... FW: Crystal Reports Training - Brendan Mc.. Mon 03/12/2018 11:12 29k8 >
Training Freeman, Jeannie RE: Citirx update Mon 03/12/2018 11:03 7KB |b
4 Qutbox [1] Robinson, James RE: Citirx update Mon 03f12/2018 10:40 54KB |*
Sent FWi ICT Service Desk Mailbox Christmas Dates - Creditors Mon 03/12/2018 10:36 5KB |*
T Freeman, Jeannie Citirx update Mon 03f12/2018 10:11 4KB |*
geds Raja, Farhad RE: Aspire on new Citrix environment Mon 03122018 10:04 100 KB |*
I Search Folders Clarke, Katy (CYTLimited) RE: Aspire on new Citrix environment Mon 03/12/2018 09:50 97 KB |*
= — P2 Iﬂ S Raja, Farhad RE: Aspire on new Citrix environment Mon 03/12/2018 09:49 79KB |*
[ij McNamara, Brendan 33KB |*

TRAMMAN f CRYSTAL Training Room Booking
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Q. How do | find where certain functionality is in Office 2016?

A. To help familiarise yourself you can use the new feature “Tell me what you want to do...”

The “Tell Me” feature is common to all applications in Office 2016 and is a great way to find where
certain menu items are without having to remember. If you’ve used the “paperclip” Office Assistant
in the past, don’t worry, this is much better and not at all obtrusive:

Inbox - Guy.Billings@york.gov.uk - Outlook

Q Tell me what you want to do...

Document3 - Waord

[;"I Tell me what you want to do...

Book1 - Excel

¢ Tell me what you want to do...

E.g. Setting your “Out of Office” in Outlook:

Suppose you need to set your “Out Of Office” replies in Outlook but you don’t know where it is. You
can use the Tell Me feature to decipher and locate what it is you're trying to do by typing into the
box.

Inbox - Guy.Eillings@york.gov.uk - Outlook

¢ out of officd
& Automatic Replies T.L Reverse &
Options - | =] pdd Calt
“| Clipboard ¥ | += Expand/(
(3<; Delete Al

Subfolders

Get Help on "out of office”

o

Smart Lockup on "out of offi...
The first option you get is Automatic Replies. This is not what you typed in but the application

recognises the phrase “Out of Office” as being dealt with by this menu item. Clicking it takes you to
the relevant item.
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Automatic Replies - Guy.Billings@york.gov.uk >

@ Do not send automatic replies
O Send automatic replies
Only send during this time range:
Start time: | Fri 03,/08/2018 15:00

End time: | Sat 04/08/2018 15:00

Automatically reply ance for each sender with the following messages:
% Inside My Crganization e Outside My Organization [OFf)

Arial 14 B I u A

Hello

| am currently on leave, back on the 5th of July. If you
have any urgent queries please contact the ICT Service
Desk on (01904) 55 2222.

Thank you
Guy

Guy Billings | ICT Citrix Project officer

Rules... 8] 4 Cancel

Q. Can | switch off notifications every time | receive an email in Outlook?

A. Yes, you can, these can be quite distracting sometimes. To do this, first select File then Options
and Mail. Under the section called Message arrival you should see the following settings:

Message arrival

ﬁj When new messages arrive:

Play a sound

Briefly change the mouse pointer
+| Show an envelope icon in the taskbar
| Display a Desktop Alert

Enable preview for Rights Protected messages (May impact performance)

Simply uncheck the Display a Desktop Alert setting and click OK.
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Q: Why can | see a message saying “This operation has been cancelled due to
restrictions in effect on this computer. Please contact your system
administrator.”? Has something gone wrong with my computer?

A: No, nothing has gone wrong. The default drive to save Outlook attachments is the C: drive. On HP
terminals you don’t have access to that drive beyond your current session which is why the message
occurs. If you click OK you should find that you are then able to navigate to another drive:

Restrictions >

e This operation has been cancelled due to restrictions in effect on this computer, Please
contact your systern administrator,

Q: Why do only 250 results come back when searching within Outlook?

A: This is a new Microsoft feature designed to improve performance, but you can override this. Once
you have searched, at the bottom of the results you will see:

This is good advice but if you don’t have any further terms that will narrow the search you can return
all of the results by clicking the Include Older Results button:

Include
Older Results

Results

This will now extend the search beyond the first 250 results and all of the results will be displayed. If
you find you are clicking this button quite often you can permanently set this by clicking Search
Tools and then Search Options on the ribbon, and removing the tick from “Improve search speed by
limiting the number of results shown”.
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Results

i Include results only from:
/(3. Current folder
® Current folder, Current mailbox when searching from the inbox
Current mailbox
All mailboxes
Include messages from the Deleted items folder in each data file when searching in All [terns
| When possible, display results as the query is typed
[ Improve search speed by limiting the number of results shown

| Highlight search terms in the results
Highlight color: | 2O -

| Motify me when results might be limited because search indexing is not complete

Q. In MS Office (Word, Excel etc) | used to be able to send documents as an
email attachment but the option doesn’t appear?

A. You can still do this. Previously you would click the Office button and select Send which then gave
you 3 options. In the new version of Office you click File then Share. This gives you 5 options, the 2™
of which is Email. Selecting this gives you a further 5 options, including Send as PDF!
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FAQ [Compatibility Maode] - Word

Share

FAQ Email

W2 = CitrixPilot @J Everyone gets a copy to review
=
Sha re Send as
Attachment
:.\.. Share with People
Everyone works on the same copy
@ Everyone sees the latest changes
| Email Keeps the emnail size small
! Document must be saved in a shared location
E@ Present Online
0 Everyone gets a PDF attachment
'.:'ﬁ‘f. Preserves layout, formatting, fonts, and images
[ ] ] Send by Instant Message Send as Content can't be easily changed
Account PDF
Options
Post to Blog 0 Everyone gets an XP5 attachment
fﬁ Preserves layout, formatting, fonts, and images
Content can't be easily changed
Send as XPS
= MNa fax machine needed
E) You'll need a fax service provider
Send as
Internet Fax
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Master-Application-List2 - Excel

©

Share

New
Master-Application-List2 Email
Open uU: 0 Everyone gets a copy to review
=
b
e Sha re Send as
Attachment
Save As °
:.-g Share with People
Print Everyone works on the same copy of this workbook
@J Everyone sees the latest changes
iz *  Email Keeps the email size small
Export ! Workbook must be saved in a shared location
5@ Present Online
Publish 0 Everyone gets a PDF attachment
'.cE"lf. Preserves layout, formatting, fonts, and images
Close [ @J ] Send by Instant Message Send as Content can't be easily changed
PDF
Account
0 Everyone gets an XPS attachment
Options '."ﬁ Preserves layout, formatting, fonts, and images
Content can't be easily changed
Send as XPS
MNao fax machine needed
CJ . .
E) You'll need a fax service provider
Send as
Internet Fax

Q. How do | change which program open my files (file associations)

A. To do this right-click the file you wish to open and choose Open with and then Choose another
app. The below file is a text document and has a .txt extension and icon. As default it would open in
Notepad. If you’d prefer to open .txt documents in Word you can either:

This time only: right-click and select Open with and choose Word 2016

Every time: right-click and select Open with, then Choose another app

D Ci 05/2018 15:16 Text Document

Open

e Print
Edit

' Open with > Mj Motepad
Restore previous versions E| Word 2016
Send to > ,E, WordPad

ose Sh
Cut Search the Store
Copy Choose another app
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You are then presented with another screen where you can choose Word 2016 and tick the box to
Always use this app to open .txt files

Q: How do | get back to my desktop if | have a lot of things open?

A: There are a number of ways you can do this! The easiest way is to click the small rectangle down
in the bottom right corner of the taskbar, next to the time and date:

1747
20/06/2018

This minimises all of your applications. If you click it again they return to how they were. Another

way is to right-click the Windows Key E and choose Desktop. Again if you repeat this the
applications you had open return to how they were. The final way to do this is to right-click the
taskbar and choose Show the desktop. The reverse of this is to right-click the taskbar and choose
Show open windows.

Q. How should | leave my workstation?

A. If you're likely to be away from your desk for an extended period we’d like you to sign out as this
clears your session from the server and the resources used by it can be reallocated. Certainly at the
end of the day we’d ask that you sign out.

Change account settings

Lock

Sign out

- LF LiWvE

R

Click on the Windows key E followed by the User icon and choose sign out.

Alternatively, right-click on the Windows key E and choose Shut down or sign out, followed by
sign out.
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